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Welcome
 Congratulations for selecting SUSE LINUX. A few clicks are all that isneeded to prepare the installation, which takes fifteen to twenty minutes.After configuring the users and their passwords and selecting the screenresolution, your SUSE LINUX system is ready for use. If you are familiarwith earlier versions of SUSE LINUX, you will notice how much the config-uration with the system assistant YaST has been expanded and simplified.The simple quick installation is explained first. If you have special wishesin connection with the programs to install, the partitioning of your harddisk, or other features, read the chapter about the custom installation. YaSTadditionally facilitates the configuration and administration of your hard-ware, Internet access, and system — without repeated reboots.
 Typographical ConventionsThe following typographical conventions are used in this book:
 /etc/passwd : files or directories
 〈placeholder〉: replace the character string 〈placeholder〉 (including theangle brackets) with the actual value
 PATH: an environment variable
 ls : commands
 user : users�� ��Alt : a key to press
 ‘File’: menu items, buttons
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 Quick Installation
 In the best case, a few clicks are sufficient to install SUSE LINUX on yourcomputer. If no Linux system was installed on your computer previously,your hard disk is partitioned, an installed Windows system is resized, asoftware selection is installed, and your hardware is configured automati-cally. If you do not like the suggestions of the system assistant YaST (Yet an-other Setup Tool) or have special requirements for your system, change theindividual installation suggestions manually as described in Chapter 2 onpage 7.
 1.1 Step One: The Start Screen . . . . . . . . . . . . . . . 21.2 Step Two: Accept Suggestions . . . . . . . . . . . . . 21.3 Step Three: Installation . . . . . . . . . . . . . . . . . 31.4 Configuration . . . . . . . . . . . . . . . . . . . . . . 3
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1.1 Step One: The Start ScreenTurn on your computer and all connected hardware components andimmediately insert CD 1 or the DVD in the respective drive. In the startscreen, select an installation mode or boot an installed operating system.Following the successful installation, the CD only needs to be inserted inthe drive occasionally to install additional software. As the CD can be for-gotten in the drive, the option to boot the installed system is preselected.For installation, use the arrow keys to select ‘Installation’.
 NoteIf your computer does not boot from CD 1 or the DVD, read Sec-tion 2.2 on page 9.
 Note
 1.2 Step Two: Accept SuggestionsAfter the system is booted from CD or DVD, the SUSE system assistantYaST is started. First, select the language for your system. The languagesetting is automatically adopted for the keyboard layout. Then YaST checksyour system. If you already installed a SUSE LINUX version on your com-puter, the next dialog asks whether to install SUSE LINUX from scratch orperform an update of your previous system.
 If Linux was not installed on your computer previously or if you select‘New installation’, YaST checks all your hardware and list the result in thesuggestion dialog, shown in Figure 1.1 on page 4. This dialog also displaysthe partitioning suggestion (possibly resizing) and the selected installationtype. If installing Linux for the first time, accept these suggestions, whichare usually suitable.
 The following messages and suggestions are displayed after the systemcheck:
 Mode ‘New installation’ is the default value here.
 Keyboard The keyboard layout defaults to the selected language. Thiscan easily be changed.
 Mouse The detected mouse type is listed here.
 2 1.1. Step One: The Start Screen
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 Partitioning Suggests a suitable partitioning. If Windows 9x or ME(FAT32 file system) exists on the hard disk, the resizing rate is indi-cated.
 Software A default system with office applications is preset.
 Booting Determines where SUSE LINUX installs the boot manager. TheMaster Boot Record (MBR) of the first hard disk is the default setting.
 Time Zone Depending on the selected language settings, the time zoneof the respective country is selected. Check this setting as many lan-guages are used in several countries.
 Language Shows the language setting.
 Modify the YaST suggestions at any time by clicking the respective head-ing. The dialogs displayed enable detailed settings. The exact procedure isdescribed in Chapter 2 on page 7. After the changes, you are returned tothe overview and can proceed with the installation using the modified val-ues by clicking ‘Accept’.
 CautionIf the hardware was detected correctly, you do not need to change any-thing. Do not change the boot loader, partitioning, or hardware settingsunless you know what you are doing.
 Caution
 1.3 Step Three: InstallationBefore the installation begins, YaST asks in a green window whether to in-stall with the current settings. Confirm the request with ‘Yes’ to start theinstallation. Depending on the performance of your computer, installationof your system with a large selection of application packages takes approxi-mately fifteen minutes.
 1.4 ConfigurationFollowing the installation, make some important settings before startingusing SUSE LINUX (see Section 2.6 on page 28 for detailed instructions).
 3SUSE LINUX – Installation Guide
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Figure 1.1: Suggestion Screen
 First, set a password for the system administrator (user ☞root).This specialuser is always configured by YaST and is needed for system maintenancetasks.
 CautionRemember the root password because you can only modify the systemor install programs using the root identity.
 Caution
 If a network card or other communication hardware (such as a modem orISDN card) is found during the installation, these can now be configuredand a connection can be established with the Internet or a local network(LAN). This enables use of various services during the remaining part ofthe procedure.
 For example, if you configure an Internet connection, can perform an on-line update immediately. In this way, include the latest updates for yoursystem.
 If you establish a connection with a local network, you can configure a
 4 1.4. Configuration
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 name service such as NIS. YaST assumes that you will not manage any lo-cal users on your system.
 This is usually the case with commercial workstations, whose users are ad-ministered centrally (e.g., on a department server). If you do not configurea name service, set up local users intended for normal operations on thesystem.
 An additional overview displays the detected screen, graphics card, andother hardware components (printer, sound card, etc.). If necessary, changesettings, such as the suggested screen resolution or the color depth. Refer toSection 2.7 on page 33. Some of the dialogs for the configuration of the ad-ditional hardware are able to search for connected devices. However, thesesettings do not need to be made at this stage. You can also skip this stepand do it later. After the completion of this last step, your newly installedsystem is booted and you can start using it.
 Have a lot of fun with SUSE LINUX!
 5SUSE LINUX – Installation Guide
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 Custom Installation
 The previous chapter covered the quick installation procedure. This chap-ter provides detailed information about the settings you can modify bystarting the relevant module from the suggestion window. This gives com-plete control over the installation.
 2.1 Starting Your System from the CD-ROM . . . . . . . 82.2 The Boot Screen . . . . . . . . . . . . . . . . . . . . . 92.3 Language Selection . . . . . . . . . . . . . . . . . . . 112.4 Installation Mode . . . . . . . . . . . . . . . . . . . . 122.5 Installation Suggestion . . . . . . . . . . . . . . . . . 122.6 Finishing the Installation . . . . . . . . . . . . . . . . 282.7 Hardware Configuration . . . . . . . . . . . . . . . . 332.8 Graphical Login . . . . . . . . . . . . . . . . . . . . . 34
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2.1 Starting Your System from the CD-ROM
 Insert the first SUSE LINUX CD or the DVD into the drive. Then reboot thecomputer to start the installation program from the medium in the drive.
 2.1.1 Possible Problems when Starting from the CD/DVD
 If you experience problems booting from CD 1, one of the following itemsis probably the cause. Resolve the problem as described.
 The CD-ROM drive is not able to read the boot image on the first CD.In this case, use CD 2 to boot the system. CD 2 contains a conven-tional 2.88 MB boot image, which can be read even by older drives.
 The boot sequence in the BIOS (Basic Input Output System) is in-correct. The BIOS is a software for activating the basic functions ofa computer. Motherboard vendors provide a BIOS that is adapted tothe hardware. Information about changing the BIOS settings is pro-vided in the documentation of your motherboard and in the follow-ing paragraphs.
 Normally, the BIOS setup can only be accessed at a specific time —when the machine is booting. During this initialization phase, the ma-chine performs a number of diagnostic hardware tests. One of themis a memory check, recognizable from the memory counter. When thecounter appears, look for a line, usually below the counter or some-where at the bottom, mentioning the key to press to access the BIOSsetup. Usually the key to press is
 �� ��Del ,�� ��F1 , or
 �� ��Esc . Press this key untilthe BIOS setup screen appears.
 To change the boot sequence in an AWARD BIOS, look for the ‘BIOSFEATURES SETUP’ entry. Other manufacturers may have a differentname for this, such as ‘ADVANCED CMOS SETUP’. When you havefound the entry, select it and confirm with
 �� ��Enter .
 In the screen that opens, look for a subentry called ‘BOOT SE-QUENCE’. The boot sequence is often set to something like C,A orA,C . In the former case, the machine first searches the hard disk (C)then the floppy drive (A) to find a bootable medium. Change thesettings by pressing
 �� ��Page up or�� ��Page down until the sequence is
 A,CDROM,C.
 8 2.1. Starting Your System from the CD-ROM
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 Leave the BIOS setup screen by pressing�� ��Esc . To save the changes, se-
 lect ‘SAVE & EXIT SETUP’ or press�� ��F10 . To confirm that your settings
 should be saved, press�� ��Y .
 If you have a SCSI CD-ROM drive, you need to change the setup ofthe SCSI BIOS. In the case of an Adaptec host adapter, for instance,open the setup by pressing
 �� ��Ctrl +�� ��A . After that, select ‘Disk Utilities’,
 which displays the connected hardware components. Make a note ofthe SCSI ID for your CD-ROM drive. Exit the menu with
 �� ��Esc thenopen ‘Configure Adapter Settings’. Under ‘Additional Options’, select‘Boot Device Options’ and press
 �� ��Enter . Enter the ID of the CD-ROMdrive and press
 �� ��Enter again. Then press�� ��Esc twice to return to the
 start screen of the SCSI BIOS. Exit this screen and confirm with ‘Yes’to boot again.
 Your CD-ROM drive may not be supported because it is an oldermodel.
 2.2 The Boot Screen‘Boot from Hard Disk’ boots the already installed system. This item is se-lected by default because the CD is often forgotten in the drive. Select ‘In-stallation’ with the arrow keys. This will load YaST and start the installa-tion.
 The boot screen provides several options for starting from the CD. The op-tions and the actions triggered by them are:
 Boot from Hard Disk: Boots the system installed on the hard disk(the system normally booted when the machine is started). This op-tion is preselected.
 Installation: The normal installation mode. All modern hardwarefunctions are enabled.
 Installation — ACPI Disabled: If the normal installation fails, thismay be due to lacking ACPI (Advanced Configuration and Power In-terface) support of the system hardware. In this case, use this optionto perform the installation without ACPI support.
 Installation — Safe Settings: The DMA mode (for CD-ROM drives)and any critical power management functions are disabled. Expertscan also use the command line to enter or change kernel parameters.
 9SUSE LINUX – Installation Guide
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Figure 2.1: The Boot Screen
 Manual Installation: If the automatic loading of drivers causes prob-lems with the installation, you can perform the installation manually.In a manual installation, drivers are not loaded automatically. How-ever, this will not work if you use a USB keyboard on your machine.
 Rescue System: If you are unable to boot into your installed Linuxsystem for some reason, you can boot the computer from the DVD orCD1 and select this item. This option starts a rescue system — a min-imal Linux system without a graphical user interface, which allowsexperts to access disk partitions for troubleshooting and repairing aninstalled system. Less experienced users can alternatively use the Sys-tem Repair tool supplied with YaST. Refer to Chapter 3 on page 37 fordetails.
 Memory Test: This tests your system RAM by means of repeated readand write cycles. This is done in an endless loop, as memory corrup-tion often shows up very sporadically, so many read and write cyclesmight be necessary to detect it. If you suspect that your RAM mightbe defective, start this test and let it run for several hours. If no errorsare detected after a longer time period, you can assume that the mem-ory is intact. Terminate the test by rebooting.
 10 2.2. The Boot Screen
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 A few seconds after starting the installation, SUSE LINUX loads a minimal☞Linux system, which takes control and performs the installation. A num-ber of messages and copyright notices are displayed then, at the end of theloading process, the YaST installation program is started. After a few moreseconds, the screen should display the graphical interface that will guideyou through the installation.The YaST screens have a common format. All buttons, entry fields, and listscan be accessed with the mouse. If your mouse pointer does not move, themouse has not been correctly detected. In this case, use the keyboard fornavigation.
 2.3 Language SelectionSelect the language to use for SUSE LINUX and YaST. English is the defaultsetting for the international distribution. If your mouse does not work, nav-igate with the arrow keys until the desired language is selected. After this,press
 �� ��Tab until ‘Next’ is highlighted. Then press�� ��Enter to confirm your lan-
 guage selection.
 Figure 2.2: Selecting the Language
 11SUSE LINUX – Installation Guide
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2.4 Installation ModeSelect between a ‘New Installation’ and an ‘Update of an installed system’.The latter is only possible if a previous version of SUSE LINUX is alreadypresent. In this case, you can also boot this system with ‘Boot Installed Sys-tem’. If your installed system fails to boot, perhaps because some importantsystem configuration has been corrupted, you can try to make the systembootable again with ‘System Repair’. Without a previously-installed ver-sion of SUSE LINUX, it is only possible to perform a new installation.
 The following sections describe the procedure of installing a new system.A description of the system repair options can be found in Chapter 3 onpage 37.
 Click ‘OK’ to continue. See Figure 2.3.
 Figure 2.3: Selecting the Installation Mode
 2.5 Installation SuggestionAfter hardware detection, the suggestion window, shown in Figure 2.4 onthe next page, displays some information about the hardware recognizedand proposes a number of installation and partitioning options. When se-lecting any of these items and configuring them in the corresponding di-
 12 2.4. Installation Mode
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 alogs, you are always returned to the suggestion window, which is updatedaccordingly. The individual settings are discussed in the following sections.
 Figure 2.4: Suggestion Window
 2.5.1 Installation Mode
 Use this to change the installation mode. The options are the same as al-ready described in Section 2.4 on the facing page.
 2.5.2 Keyboard Layout
 Select the keyboard layout. By default, the layout corresponds to the se-lected language. After changing the layout, test Y, Z, and special charactersto make sure the selection is correct. When finished, select ‘Next’ to returnto the suggestion window.
 13SUSE LINUX – Installation Guide
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2.5.3 Mouse
 If YaST did not detect your mouse automatically, press�� ��Tab in the sugges-
 tion window several times until ‘Mouse’ is selected. Then use�� ��Space to
 open the dialog in which to set the mouse type. This dialog is shown in Fig-ure 2.5.
 Figure 2.5: Selecting the Mouse Type
 To select the mouse type, use�� ��↑ and
 �� ��↓ . Consult the mouse documentationfor information about the mouse type. After selecting a mouse type, use�� ��Alt +
 ����T to test whether the device works correctly without selecting it per-manently. If the mouse does not behave as expected, use the keyboard toselect another type and test again. Use
 �� ��Tab and�� ��Enter to make the current
 selection permanent.
 2.5.4 Partitioning
 In most cases, YaST proposes a reasonable partitioning scheme that canbe accepted without change. If desired, modify this scheme to meet yourneeds or create a new one.
 14 2.5. Installation Suggestion

Page 23
                        
                        

2C
 usto
 mIn
 stalla
 tion
 Partition Types
 Every hard disk has a partition table with space for four entries. Each entryin the partition table can be a primary partition or an extended partition.Only one extended partition entry is allowed, however.
 Primary partitions consist of a continuous range of cylinders (physical diskareas) assigned to a particular operating system. Using primary partitions,you could not set up more than four partitions per hard disk. More do notfit in the partition table.
 This is why extended partitions are used. Extended partitions are also con-tinuous ranges of disk cylinders, but an extended partition may itself besubdivided into logical partitions. Logical partitions do not require entries inthe partition table. In other words, an extended partition is a container forlogical partitions.
 If you need more than four partitions, create an extended partition. Thisextended partition should span the entire remaining free cylinder range.Then create multiple logical partitions within the extended partition. Themaximum number of logical partitions is fifteen on SCSI disks and 63 on(E)IDE disks.
 It does not matter which type of partitions are used for Linux. Primary andlogical partitions both work fine.
 Required Disk Space
 The amount of hard disk space needed depends on the intended use of thesystem. Available space limits what applications can be installed. The fol-lowing hints give some guidelines for space requirements:
 Minimal system: 180 MB
 No graphical interface (X Window System) is installed, which meansonly console applications can be used. Also, only a very basic selec-tion of software is installed.
 Minimal system with graphical interface: 500 MB
 This includes X and some applications.
 Graphical system with modern applications: between 1 GB and 2 GB
 This includes recent versions of graphical desktops, namely KDE andGNOME, and bigger application packages, such as OpenOffice.organd Netscape or Mozilla.
 For downloading movies and music with Linux: 2 GB
 15SUSE LINUX – Installation Guide
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Both items: 3 GB
 Burning CDs and the items listed above: 4 GB
 These guidelines can help develop a partitioning scheme for your system:
 Under 500 MB:
 A swap partition and a root partition (/ ).
 Between 500 MB and 4 GB:
 A small boot partition located within the first cylinders of the hard disk(/boot , at least 8 MB or 1 cylinder) to hold the kernel and the bootloader. Also create a swap partition of approximately 256 MB thenuse the rest for the root partition (/ ).
 For more than 4 GB:
 Boot (/boot ), swap, root (250 MB), home directories (/home ) withabout 200 MB for each user, and the rest for programs and data(/usr ). You may also reserve an extra partition each for /opt and/var .
 Some commercial programs install their data in /opt . If necessary, createa separate partition for /opt or make the root partition large enough. KDEand GNOME are also installed in /opt .
 NoteThings should be fine if your partitioning setup is similar to that pro-posed by YaST. This is usually a small partition for /boot at the begin-ning of the hard disk (about 10 MB, or 1 cylinder on a large hard disk),a swap partition (between 128 and 256 MB), and the rest for / .
 Note
 Partitioning with YaST
 When you select the partitioning item in the suggestion window for thefirst time, YaST displays a dialog listing the partition settings as currentlyproposed. Accept these current settings without change or change thembefore continuing. Alternatively, discard all the settings and start over fromscratch.
 Nothing in the partitioning setup is changed if you select ‘Accept Sug-gested Partitioning Setup’. If you select ‘Change Suggested Partitioning
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 Figure 2.6: Editing the Partitioning Setup
 Setup’, the ‘Expert Partitioner’ opens. It allows you to tweak the partitionsetup in every detail. The original setup as proposed by YaST is offeredthere as a starting point.
 If you select ‘Create custom partitioning setup’, a dialog, like that in Fig-ure 2.7 on the following page, opens in which to select a hard disk fromthose on your system. SUSE LINUX will be installed on the disk selected inthis dialog.
 The next step is to determine whether the entire disk should be used (‘Useentire hard disk’) or whether to use any existing partitions, if available, forthe installation. If a Windows operating system was found on the disk orif there is some other FAT file system, select whether to delete or resizethe partition. Before doing so, read Section 2.5.4 on page 20. If desired, goto the ‘Expert Partitioner’ dialog to create a custom partition setup at thispoint.
 CautionIf you choose ‘Use entire hard disk’, all data on that disk will be lost.
 Caution
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Figure 2.7: Selecting the Hard Disk
 YaST checks during the installation whether the disk space is sufficient forthe software selection made. If not, YaST automatically removes parts fromthe software selection as needed. The suggestion window then includesa notice to inform you about this. As long as there is sufficient disk spaceavailable, YaST simply accepts your settings and partitions the hard diskaccordingly.
 Creating a Partition
 1. Select ‘New’. If several hard disks are connected, a selection dialogappears in which to select a hard disk for the new partition. Then,specify the partition type (primary or extended). Create up to fourprimary partitions or up to three primary partitions and one ex-tended partition. Within the extended partition, you can create sev-eral logical partitions (see Section 2.5.4 on page 15).
 2. Select the file system to use to format the partition and a mount point,if necessary. YaST suggests a mount point for each partition created.Details of the parameters are provided in the next section.
 3. Select ‘OK’ to apply your changes.
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 The new partition is then listed in the partition table. If you click ‘Next’, thecurrent values are adopted and you are returned to the suggestion screen.
 Partitioning Parameters
 If you create a new partition or modify an existing partition, various pa-rameters can be set in the partitioning tool. For new partitions, suitable pa-rameters are set by YaST and usually do not require any modification. Toperform manual settings, proceed as follows:
 1. Select the partition.
 2. ‘Edit’ the partition and set the parameters:
 File System IDEven if you do not want to format the partition at this stage, as-sign it a file system ID to ensure that the partition is registeredcorrectly. Possible values include ‘Linux’, ‘Linux swap’, ‘LinuxLVM’, ‘Linux EVMS’, or ‘Linux RAID’. Refer to the Administra-tion Guide for details on LVM, EVMS and RAID.
 File SystemTo format the partition immediately within the scope of the in-stallation, specify one of the following file systems for the parti-tion: ‘Swap’, ‘Ext2’, ‘Ext3’, ‘ReiserFS’, or ‘JFS’.Swap is a special format that makes the partition usable as vir-tual memory. Every system should have at least one swap par-tition of at least 128 MB (see note on the next page). ReiserFS isthe default for Linux partitions. ReiserFS as well as JFS and Ext3are journaling file systems. These file systems are able to restoreyour system very quickly after a system crash, as write processesare logged during the operation. Furthermore, ReiserFS is veryfast in handling lots of small files. Ext2 is not a journaling filesystem. It is rock solid and good for smaller partitions, as it doesnot require too much disk space for management.
 File System OptionsHere, specify various parameters for the selected file system.Depending on the file system used, various options are offered.Only make changes if you are absolutely sure what you are do-ing.
 Encrypt File System
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Page 28
                        
                        

If you activate the encryption, all data is written to the hard diskin encrypted form. This increases the security of sensitive data,but reduces the system speed, as the encryption takes some time.
 fstab OptionsHere you can specify various parameters for the administrationfile of the file systems (/etc/fstab ). Experienced users havethe possibility to modify a number of options. Refer to the rele-vant chapter in the Administration Guide before changing any-thing.
 Mount PointThis specifies the directory at which the partition should bemounted in the file system tree. Various YaST suggestions canbe expanded at the respective entry field. If you accept thesesuggestions, the default file system structure is implemented.However, you can also specify any other names.
 3. Select ‘Next’ to activate the partition.
 NoteIf you partition manually, create a swap partition. The swap partition isused to free the main memory from data that is not used at the presentmoment. This keeps the main memory free for the most frequently-used important data.
 Note
 Resizing a Windows Partition
 If a hard disk containing a Windows FAT or NTFS partition was selectedas installation target, YaST offers to delete or shrink this partition. In thisway, you can install SUSE LINUX even if there is currently not enoughspace on the hard disk. This functionality is especially useful if the selectedhard disk contains one Windows partition that covers the entire hard disk,which is often the case with preinstalled computers. If YaST sees that thereis not enough space on the selected hard disk, but that space could be madeavailable by deleting or shrinking a Windows partion, it will present a dia-log in which to choose one of these two options.
 If you select ‘Delete Windows completely’, the Windows partition will bemarked for deletion, and the space will be used for the installation of SUSELINUX.
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 Figure 2.8: Possible Options for Windows Partitions
 CautionIf you delete Windows, all data will be lost beyond recovery as soon asthe formatting starts.
 Caution
 To shrink the Windows partition, interrupt the installation and boot Win-dows in order to prepare the partition from there. Although this step is notstrictly required for FAT partitions, it speeds up the resizing process andalso makes it safer. These steps are vital for NTFS partitions.
 FAT file system In Windows, first run scandisk to make sure the FATpartition is free of lost file fragments and crosslinks. After that, rundefrag to move files to the beginning of the partition. This will accel-erate the resizing procedure in Linux.
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NoteIf you have optimized virtual memory settings for Windows insuch a way that a contiguous swap file is used with the sameinitial (minimum) and maximum size limit, consider anotherstep. With these Windows settings, the resizing might have theeffect that the swap file is split into many small parts scatteredall over the FAT partition. Also, the entire swap file would needto be moved during the resizing, which makes the process ratherslow. It is therefore useful to unset these Windows optimizationsfor the time being and reenable them after the resizing has beencompleted.
 Note
 NTFS file system In Windows, run scandisk and defrag to move thefiles to the beginning of the hard disk. In contrast to the FAT file sys-tem, this must be done in NTFS to enable resizing.
 NoteIf you operate your system with a permanent swap file on anNTFS file system, this file may be located at the end of the harddisk and remain there despite defrag. Therefore, it may be impos-sible to shrink the partition sufficiently. In this case, temporarilydeactivate the swap file (the virtual memory in Windows). Afterthe partition has been resized, reconfigure the virtual memory.
 Note
 After these preparations, return to the Linux partitioning setup and se-lect ‘Shrink Windows Partition’. After a quick check of the partition, YaSTopens a dialog with a suggestion for resizing the Windows partition.
 The first bar graph shows how much disk space is currently occupied byWindows and how much space is still available. The second bar graphshows how the space would be distributed after the resizing, accordingto YaST’s current proposal (Figure 2.9 on the facing page). Accept the pro-posed settings or use the slider to change the partition sizing (within cer-tain limits).
 If you leave this dialog by selecting ‘Next’, the settings will be stored andyou will be taken back to the previous dialog. The actual resizing will takeplace later, before the hard disk is formatted.
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 Figure 2.9: Resizing the Windows Partition
 NoteWindows Systems Installed on NTFS PartitionsBy default, the Windows versions NT, 2000, and XP use the NTFS filesystem. Unlike FAT file systems, NTFS file systems can (currently) onlybe read from Linux. Therefore, you can read your Windows files fromLinux, but you cannot edit them. If you want write access to your Win-dows data and do not need the NTFS file system, reinstall Windowson a FAT32 file system. In this case, you will have full access to yourWindows data from SUSE LINUX.
 Note
 2.5.5 Software
 SUSE LINUX contains a number of software packages for various applica-tion purposes. As it would be burdensome to select the needed packagesone by one, SUSE LINUX offers three system types with various instal-
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lation scopes. Depending on the available disk space, YaST selects one ofthese basic systems and displays it in the suggestion screen.
 Minimum System (only recommended for special purposes)
 This installs the operating system with various services without thegraphical user interface. The machine can only be operated by way ofthe ASCII consoles. This system type is especially suitable for serverapplications requiring little direct user interaction.
 Minimum Graphical System (without KDE)
 If you do not want the KDE desktop or if the disk space is insuffi-cient, install this system type. The installed system includes an ele-mentary graphical user interface with terminal windows, but no realdesktop with the usual functionality. You can use all programs thathave their own graphical user interfaces (such as Netscape). No officeprograms are installed.
 Default System (with KDE and office package)
 This is the largest of all offered basic systems. It contains the KDEdesktop together with most of the KDE programs and the office pro-grams. This is the most suitable system type for normal stand-alonemachines. If possible, YaST selects this system type.
 Click ‘Software Selection’ in the suggestion screen to open a dialog inwhich to select one of the basic systems. To start the software installationmodules (package manager) and modify the installation scope, click ‘De-tailed Selection’ (see Figure 2.10 on the next page).
 Changing the Installation Scope
 If you install the default system, there is usually no need to add or removeindividual packages. This basic system consists of a software selection thatmeets most requirements without any changes. If you have specific needs,modify this selection with the package manager. It offers various filtercriteria for determining a selection from the numerous packages in SUSELINUX.
 The filter selection box is located at the top left under the menu bar. Atstart-up, the ‘Selections’ filter is active. This filter groups the program pack-ages by their application purpose, such as multimedia or office applica-tions. The various groups of the Selections filter are listed under the filter
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 Figure 2.10: Installing and Removing Software with the YaST Package Manager
 selection box. The packages included in the selected system type are prese-lected. Click the respective check boxes to select or deselect entire selectionsfor installation.The right part of the window displays a table listing the individual pack-ages included in the current selection. The leftmost table column shows thecurrent status of each package. Two status flags are especially relevant forthe installation: Install (the box in front of the package name is checked)and Do Not Install (the box is empty). To select or deselect individual soft-ware packages, click the status box until the desired status is displayed.Alternatively, right-click the package line to access a pop-up menu listingvarious status options. However, the other status settings are not neededfor the installation.
 Other FiltersClick the filter selection box to view the range of possible filters. The se-lection according to ‘Package Groups’ can also be used for the installation.This filter sorts the program packages by subjects in a tree structure to theleft. The more you expand the branches, the more specific the selection ofpackages is and the fewer packages that are displayed in the list of associ-ated packages to the right.
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Use ‘Search’ to search for a specific package.
 Package Dependencies and Conflicts
 Instead of rewriting the same basic functions in each software package,programmers access the functions of other packages. For this reason, manypackages require that other packages are installed for the programs to func-tion. In rare cases, programs interfere with each other, causing conflicts.When selecting and deselecting software packages in this dialog, alertsabout unresolved package dependencies or conflicts may be displayed.If you install SUSE LINUX for the first time or if you do not understandthe alerts, read Section ?? on page ??, which provides detailed informationabout the operation of the package manager and a brief summary of thesoftware organization in Linux.
 CautionThe software preselected for installation is based on long-standingexperience and is usually suitable for the needs of most newcomersand advanced home users. In general, there is no need to change any-thing here. However, if you decide to select or deselect any packages,you should be aware of the consequences. In particular, observe anywarnings and avoid deselecting any packages of the base system.
 Caution
 Exiting the Software Selection
 When satisfied with your software selection and there are no more un-resolved package dependencies or conflicts, click ‘Accept’ to apply yourchanges and exit the program. If this module is started in the installed sys-tem, the changes are applied immediately. During the installation, how-ever, the changes are recorded internally and applied later when the actualinstallation starts.
 2.5.6 Boot Configuration (Boot Loader Installation)
 During the installation, YaST proposes a boot configuration for your sys-tem. Normally, you should leave these settings unchanged. However, ifyou need a custom setup, modify the proposal for your system.
 One possibility is to configure the boot mechanism to rely on a special bootfloppy. Although this has the disadvantage of requiring the boot floppy in
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 the drive for boot, it allows you to leave an existing boot mechanism un-touched. This should not normally be necessary, however, because YaSTcan configure the boot loader to boot existing operating systems as well.Another possibility with the configuration is to change the location of theboot mechanism on the hard disk.
 To change the boot configuration proposed by YaST, select ‘Booting’ toopen a dialog in which to change many details of the boot mechanism.
 NoteThe boot method should only be changed by experienced computerusers.
 Note
 2.5.7 Time Zone
 In this dialog, shown in Figure 2.11 on the next page, choose betweenLocal Time and UTCunder ‘Hardware clock set to’. The selection de-pends on how the hardware (BIOS) clock is set on your machine. If it is setto GMT, which corresponds to UTC, your system can rely on SUSE LINUXto switch from standard time to daylight savings time and vice versa.
 2.5.8 Language
 The language was already selected at the beginning of the installation (seeSection 2.3 on page 11. If you want to change this setting, you can do thishere. Furthermore, advanced users can use the ‘Details’ button to set thelanguage for the user root . The drop-down menu offers three options:
 ctype The value of the variable LC_CTYPEin the file /etc/sysconfig/language is adopted for the user root . This sets the localization forlanguage-specific function calls.
 yes The user root has the same language settings as the local user.
 no The language settings for the user root are not affected by the lan-guage selection.
 Click ‘OK’ to complete the configuration or ‘Discard’ to undo yourchanges.
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Figure 2.11: Selecting the Time Zone
 2.5.9 Launching the Installation
 When satisfied with the installation settings, click ‘Next’ to begin the in-stallation. Confirm with ‘Yes’ in the green dialog that opens. Installationusually takes between fifteen and thirty minutes, depending on system per-formance and the software selected.
 2.6 Finishing the InstallationAfter completing the basic system setup and the installation of all selectedsoftware packages, provide a password for the account of the system ad-ministrator (the root user). Then configure your Internet access and net-work connection, if available. With a working Internet connection, it is pos-sible to update the system with security patches and software updates dur-ing installation. If desired, configure a name server for centralized user ad-ministration in a local network. Also configure any hardware devices, suchas printers and scanners.
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 2.6.1 root Password
 ☞root is the name of the superuser, the administrator of the system. Un-like regular users, which may or may not have permission to do certainthings on the system, root has unlimited power to do anything: changethe system configuration, install programs, and set up new hardware. Ifusers forget their passwords or have other problems with the system, rootcan help. The root account should only be used for system administration,maintenance, and repair. Logging in as root for daily work is rather risky:a single mistake could lead to many system files being irretrievably lost.Figure 2.12 shows the relevant dialog. For verification purposes, the pass-word for root must be entered twice. Do not forget the root password. Itcannot be retrieved later.
 CautionThe user root has all the permissions needed to make changes to thesystem. To carry out such tasks, the root password is required. Youcannot carry out any administrative tasks without this password.
 Caution
 Figure 2.12: Setting the root Password
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2.6.2 Network Configuration
 In this step, configure network devices for a connection to the outsideworld. If you have these devices, such as network cards, modems, andISDN or DSL hardware, it is a good idea to configure them now. An Inter-net connection allows YaST to retrieve any available SUSE LINUX updates.
 Figure 2.13: Configuring the Network Devices
 Configure your network hardware here. Otherwise choose to ‘Skip Net-work Setup’ and confirm this with ‘Continue’. The network hardware canalso be configured after system installation has completed.
 2.6.3 Testing the Internet Connection
 If you configured an Internet connection, you can test it right now. For thispurpose, YaST establishes a connection to the SUSE server and checks ifany product updates are available for your version of SUSE LINUX. Also,the latest release notes are downloaded. Any available updates can be in-stalled in the next step.
 If you do not want to test the connection at this point, select ‘Skip Test’ then‘Next’. This also skips downloading product updates and release notes.
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 Figure 2.14: Testing the Internet Connection
 2.6.4 Loading Software Updates
 If YaST was able to connect to the SUSE servers, select whether to performa YaST online update. If there are any patched packages available on theservers, you can download and install them now to fix known bugs or se-curity issues.
 NoteThe download of updates might take quite some time, depending onthe bandwidth of the Internet connection and on the size of the updatefiles.
 Note
 To perform a software update immediately, select ‘Perform Update Now’and click ‘OK’. This opens YaST’s online update dialog with a list of theavailable patches (if any), which can be selected and loaded. This kind ofupdate can be performed at any time after the installation. If you prefer notto update now, select ‘Skip Update’ then click ‘OK’.
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2.6.5 Creating Local User Accounts
 When user accounts are created locally, any data related to user accounts(name, login, password, and so on) is stored and managed on this host.Linux is an operating system that allows several users to work on the samesystem at the same time. Each user needs a ☞user account to log in to thesystem. By having user accounts, the system gains a lot in terms of security.Regular users cannot change or delete files needed for the system to workproperly. Similarly, the personal data of a given user cannot be modified,viewed, or tampered with by other users. Each user can set up his ownworking environment and always find it unchanged when logging backin.
 Figure 2.15: Entering the User Name and Password
 A user account can be created using the dialog shown in Figure 2.15. Afterentering the first name and last name, specify the user name (login). If youcannot think of a suitable user name, click ‘Suggestion’ for the system togenerate one automatically.
 Finally, enter a password for the user. Reenter it for confirmation (to ensurethat you did not type something else by mistake). The user name tells thesystem who a user is and the password is used to verify this identity.
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 CautionRemember both your user name and the password because they areneeded each time you log in to the system.
 Caution
 To provide effective security, a password should be between five and eightcharacters long. The maximum length for a password is 128 characters.However, if no special security modules are loaded, only the first eightcharacters are used to discern the password. Passwords are case-sensitive.Special characters like umlauts are not allowed. Other special characters(7-bit ASCII) and the digits 0 to 9 are allowed.
 Two options are available for local users:
 ‘Receive system messages via e-mail’Checking this box sends the user messages created by the system ser-vices. These are usually only sent to root , the system administrator.This option is useful for the prominently-used user account, becauseit is highly recommended to log in as root only in special cases.
 ‘Automatic login’ This option is only available if KDE is used as the de-fault desktop. It automatically logs the current user into the systemwhen it starts. This is mainly useful if the computer is operated byonly one user.
 NoteNo authentication is performed during system start-up with au-tomatic login. Do not check this option for systems containingsensitive data or to which other people have access.
 Note
 2.7 Hardware ConfigurationConfigure the graphics card and, if desired, other hardware devices, suchas the printer and the sound card. Just click a component to start its con-figuration. For the most part, YaST then detects and configures the devicesautomatically.
 You may skip any peripheral devices and configure them later. However,you should configure the graphics card right away. Although the display
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Figure 2.16: Configuring the System Components
 settings as autoconfigured by YaST should be generally acceptable, mostusers have very strong preferences as far as resolution, color depth, andother graphics features are concerned. To change these settings, select ‘XConfiguration’. When finished, click ‘Finish Installation’.
 After YaST has written the configuration data, you can finish the installa-tion of the SUSE LINUX with ‘Finish’ in the final dialog.
 2.8 Graphical LoginSUSE LINUX is now installed. You can start right away without passingthe login procedure if you checked automatic login in the local user ad-ministration module. If not, the graphical ☞Login window shown in Fig-ure 2.17 on the next page is displayed on your screen. Enter a previouslydetermined user name and password to log in to the system.
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 Figure 2.17: The Login Screen
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 YaST System Repair
 Despite its robustness, the SUSE LINUX system can be damaged by con-figuration blunders or other “accidents”. While this is quite unlikely whenlogged in as a regular user, the superuser root is allowed to change all sys-tem files and configuration, making it possible for him to accidentally causedamage. There are good chances of putting the system back on track withthe YaST System Repair in such a case. It is impossible to correct all imagin-able defects, but many of the common problems can be solved.
 3.1 Starting YaST System Repair . . . . . . . . . . . . . . 383.2 Automatic Repair . . . . . . . . . . . . . . . . . . . . 39
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3.1 Starting YaST System RepairBecause it cannot be assumed that a damaged system can boot by itself anda running system cannot be easily repaired, the YaST System Repair utilityis run from the SUSE LINUX installation CD or DVD. Follow the steps out-lined in Chapter 2 on page 7 to get to the dialog page offering the variousinstallation options and select ‘Repair Installed System’. See Figure 3.1.
 Figure 3.1: Selecting the YaST System Repair Utility
 NoteBecause the test and repair procedure is loaded from CD or DVD, it isessential to run it from an installation medium that exactly correspondsto your installed version of SUSE LINUX.
 Note
 In the next step, choose how the system repair should be performed. Thefollowing options are available and are described below:
 Automatic repair
 User-defined repair
 Expert tools
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 3.2 Automatic RepairThis method is best suited to restoring a damaged system with unknowncause. Selecting it starts an extensive analysis of the installed system, whichwill take quite some time due to the large amount of tests and exami-nations. The progress of the procedure is displayed at the bottom of thescreen with two progress bars. The upper bar shows the progress of thecurrently running test. The lower bar shows the overall progress of theanalysis process. The log window above allows tracking of the currentlyrunning activity and its test result. See Figure 3.2. The following main testruns are performed with every run. They contain, in turn, a number of indi-vidual subtests.
 Figure 3.2: Automatic Repair Mode
 Partition tables of all hard disks The validity and coherence of the parti-tion tables of all detected hard disks are checked.
 Swap partitions The swap partitions of the installed system are detected,tested, and offered for activation where applicable. The offer shouldbe accepted for the sake of a higher system repair speed.
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File systems All detected file systems are subjected to a file system–specific check.
 Entries in the file /etc/fstab The entries in the file are checked forcompleteness and consistence. All valid partitions are mounted.
 Boot loader configuration The boot loader configuration of the installedsystem (GRUB or LILO) is checked for completeness and coherence.Boot and root devices are examined and the availability of the initrdmodules is checked.
 Package database This checks whether all packages necessary for the op-eration of a minimal installation are present. While it is optionallypossible to also analyze the base packages, this takes a long time be-cause of their vast number.
 Whenever an error is encountered, the procedure is stopped and a dialogopens, offering details and possible solutions. It is not possible to describeall these cases. Read the notifications on the screen carefully and choose thedesired action from the list options. It is also possible to decline the offeredrepair action in cases of doubt. The system remains unaltered in this aspectand no repair is ever performed automatically and without prompting theuser.
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 The KDE Desktop
 KDE is the default desktop in a standard installation of SUSE LINUX. It iseasy to use and highly configurable. The following sections introduce thebasic desktop and customization of the desktop. Konqueror is essential forfile management. A number of additional applications are also described.
 4.1 Desktop Components . . . . . . . . . . . . . . . . . . 424.2 Settings . . . . . . . . . . . . . . . . . . . . . . . . . . 494.3 Konqueror as a File Manager . . . . . . . . . . . . . 584.4 Important Utilities . . . . . . . . . . . . . . . . . . . 61
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4.1 Desktop ComponentsThe graphical desktop environment should not pose any problems for for-mer Windows or Macintosh users. The main components are the icons onthe desktop and the panel at the bottom of the screen. The mouse is yourmost important tool. Click a symbol or an icon once to start the associatedprogram or the file manager Konqueror. If you right-click an icon, differentmenus appear, depending on the program. As well as the icons, there aretwo desktop menus.
 4.1.1 The Desktop Menus
 If you middle-click the desktop (if your mouse only has two buttons, pressboth buttons at the same time), a window and desktop management menuare displayed. If you keep the mouse button pressed, select a menu itemdirectly. Alternatively, release the mouse button and click the respectivemenu item.
 Unclutter Windows If you have several windows on your desktop, theyare placed next to each other and aligned with the top left corner.
 Cascade Windows Starting from the top left corner, the windows on thedesktop are placed on top of each other in such a way that only thetop and left borders of the lower windows are visible.
 Desktop 1 Desktop 1 is your default desktop. All open windows arelisted under this menu item. Click windows to move them to the fore-ground.
 additional desktop You can use additional virtual desktops. Switch toanother desktop with the menu or the panel. All functions are avail-able on all desktops. This limits the number of programs and associ-ated windows that need to be arranged on one desktop. These virtualdesktops resemble additional desks in your office.
 If you right-click the desktop, a more complex menu is displayed, allowingyou to customize your desktop.
 Create New Enables creation of new elements, such as directories, files,or URLs, on the desktop. A list of possible elements is provided forselection in a submenu.
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 Bookmarks This item opens the bookmark editor KEditBookmarks. Withit, create, group, change, or delete bookmarks. The browser and filemanager Konqueror can access these bookmarks.
 Undo This option allows you to undo the last action. For example, if youjust created a new directory on the desktop, clicking this item revertsthe creation so the directory disappears.
 Paste To have a desktop icon for a folder or document, copy the icon fromthe file manager by right-clicking and selecting ‘Copy’ then movingthe mouse to the desired location on the desktop. Right-click againand select ‘Paste’. The icon is now available on your desktop and canbe moved around by dragging it with the left mouse button pressed.
 Icons Rearranges the symbols on the desktop. You can also change theorder of the icons.
 Windows The windows on the desktop are either placed on top of eachother at the top left corner or next to each other.
 Configure Desktop This menu item starts a configuration dialog withwhich to configure the appearance of the desktop. Details about theconfiguration of the desktop are provided in Section 4.2 on page 49.
 Help Use this submenu to open the KDE manual or write a bug report tothe developers via the KDE web site. You can also start an informa-tion page about KDE.
 Lock Screen If you leave your workstation and do not log out, youshould use this function to prevent others from gaining access toyour files. Depending on the setting, the screen either turns black ora screensaver starts. To continue using the computer, enter your pass-word.
 Logout User Log out from your system if you are not going to use thesystem for some time.
 4.1.2 The Trash Bin
 The trash bin is a directory for files marked for deletion. Drag icons fromthe file manager or the desktop to the trash bin icon by keeping the leftmouse button pressed then release to drop them there. Alternatively, right-click an icon and select ‘Move to Trash’ from the menu. Click the trash binicon to view its contents. You can retrieve an item from the trash if desired.
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Files removed with ‘Delete’ are not moved to the trash bin, but deletedcompletely. To delete the files in the trash bin completely, right-click thetrash bin icon and select ‘Empty Trash Bin’.
 4.1.3 CD-ROM, DVD-ROM, and Floppy Disks
 If you click the floppy disk icon when a floppy disk is inserted, the filemanager starts and displays the content of the floppy disk. Display a con-text menu with various options by right-clicking the individual icons onthe floppy disk. It is also possible to move the icon to a different location,such as the desktop or your home directory, by simply keeping the leftmouse button pressed and dragging it to the appropriate icon. You will beasked whether you want to move or copy the file or create a link. You canalso copy or move files from your home directory to the floppy disk.
 Right-click the floppy disk icon to access the context menu. ‘Unmount’ isa very important option. Be sure to unmount the drive before removing afloppy disk from the drive, as this is necessary to trigger the actual writingof the data to the floppy disk.
 The handling of CDs and DVDs is similar, with the only difference thatthese media are not writable. Nevertheless, you must unmount CD andDVD drives, because otherwise you will not be able to eject the CD. Youcan also select ‘Eject’, which causes the medium to be unmounted andejected. Both methods only work if the CD or DVD is no longer accessedand any file manager window displaying the content of the CD or DVD hasbeen closed.
 4.1.4 The Printer Icon
 Click the printer icon on the desktop to start KPrinter. This program en-ables you to adjust a number of settings and send print jobs directly. Theupper part of the main window, like that in Figure 4.1 on the facing page,shows the selected printer and allows selection of a different printer. Clickthe black arrow next to the printer name to display a list of all availableprinters and select the desired printer.
 To configure the selected printer, click ‘Properties’. A configuration dialoglike that shown in Figure 4.2 on page 46 opens, enabling you to change thepaper format (e.g., from A4 to letter) or change between multiple papertrays. The latter is especially useful if one of the trays contains letterheadpaper and another contains plain white paper.
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 Figure 4.1: The Main Window of KPrinter
 Under ‘Orientation’, choose between ‘Portrait’ and ‘Landscape’. To theright of ‘Orientation’, specify the settings for two-sided printing. If ‘None’is selected, only one page is printed per sheet. If you click the circle pre-ceding ‘Long side’, the front and back will be printed like in a book. With‘Short side’, the back is printed reversely and you have to turn the sheetup to view the text correctly. Under ‘Start/End’, mark your document withheadlines and subtitles, such as “confidential” or “secret”. Under ‘Pagesper Sheet’, select to print two or four pages on one sheet. For this purpose,the pages are downsized accordingly. If you click ‘Save’, your settings areadopted for other print jobs, too. However, if you click ‘OK’, the settingsonly apply to the current job. If you terminate the dialog with ‘Cancel’, allchanges are discarded.
 After making all settings, click ‘Expand’. The second part of the windownow becomes visible. Click the blue folder icon. By default, your home di-rectory is displayed. Select a file and confirm with ‘OK’. You can also se-
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Figure 4.2: Settings in KPrinter
 lect the file by double-clicking it. The respective file then appears in theoverview of the main window, together with the name, type, and pathspecification. Now click ‘Print’ to send the job to the printer. The job isplaced in the queue and can be monitored with KJobViewer. On the otherhand, if you click the document, two additional buttons become active tothe right. Use the X button to remove the document from the selection oruse the magnifying glass icon to display, edit, and save the file with Kwriteor OpenOffice.org (depending on the document type). Afterwards, sim-ply close the editing program and click ‘Print’ in the KPrinter dialog. Yourchanges are then adopted for printing.
 All KDE applications use KPrinter for printing. For example, if you clickthe printer icon in KWrite, the KPrinter dialog appears. The file to print isalready preselected.
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 4.1.5 The Panel
 The panel at the lower edge of the screen consists of several areas. By de-fault, the icon for the main menu is located to the far left. Other icons arelined up alongside it. The house icon provides quick access to your homedirectory with all subdirectories. The other icons start applications, such asOpenOffice.org, K-Mail, and the web browser Konqueror, if these pro-grams were installed.
 Next to these icons are the numbered buttons with which to switch desk-tops. These multiple desktops enable you to organize your work if youuse many programs simultaneously, as if you had several desks for varioustasks.
 The taskbar is located next to the virtual desktops. All started applicationsare displayed in the taskbar. If you click a window title in the taskbar, theapplication is moved to the foreground. If it is already in the foreground,clicking minimizes the application. If you click it again, it reopens. Next tothe taskbar, find applets, such as the clipboard Klipper, SuSEwatcher, andany other applets you have started. The clock helps you keep track of thetime.
 If you right-click an empty space in the panel, a menu providing the usualhelp and configuration options for the panel is displayed. Use the menu tochange the size of the panel and add and remove applications. To add anapplication, search for the respective application in the menu and select it.Remove applications or applets by right-clicking the corresponding iconand selecting ‘Remove’ from the displayed menu.
 4.1.6 The Main Menu
 Access the main menu by means of the icon to the far left of the panel. Bydefault, this menu contains entries for logging out from the system, lockingthe screen, executing commands, and starting the quick browser and thebookmark manager. Use the file manager to display your home directory,search for files, or start the Control Center for the purpose of customizingthe desktop. The other menu entries allow you to start a variety of pro-grams sorted by subjects. The following section provides information aboutselected functions that you can start by means of the main menu. Detailedinformation about the Control Center is available in Section 4.2 on page 49.
 Logout User You can log out from the system by means of this menuitem. However, first you will be asked what should happen after the
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logout. If you select the ‘Login as different user’, the login screen isdisplayed, allowing you or another user to log in to the system. Youcan also turn off or restart the computer. Confirm your selection with‘OK’ or remain logged in by clicking ‘Cancel’.
 Lock Screen If you leave your workstation, you can blacken your screenor start a screensaver. To restore the session view, enter your normallogin password. In this way, make sure no one reads or manipulatesyour documents or e-mail messages.
 Start New Session To start a second session with a graphical user inter-face on your machine, select ‘Start New Session’ from the main menu.Your current session remains active while you are taken to the lo-gin screen. Log in. You can also start another window manager. Ac-cess the first session by pressing
 �� ��Ctrl +�� ��Alt +
 �� ��F7 . Press�� ��F8 instead of�� ��F7 to access the new session. Additional sessions can be accessed by
 pressing�� ��Ctrl +
 �� ��Alt +�� ��F9 to
 �� ��F12 .
 Run Command Enter a command in the dialog that opens. In this way,easily start applications whose name you know without having tonavigate through the menu.
 Bookmarks By way of this menu, start the bookmark editor with ‘EditBookmarks’ to manage your bookmarks. If you select a bookmarkfrom the menu, the browser starts and loads the desired URL.
 Search ‘Search’ starts the program KFind. Use ‘Help’ to access the pro-gram manual, which provides information about all details. If youforget where a certain file is, enter it in the ‘Named’ field and start asearch in your home directory. This default setting can be changedto a different directory, such as Documents , by clicking ‘Browse’. Ifyou are not sure what the exact file name is, use wild cards. If youcan remember that the file name contains the character string blubb ,simply enter *blubb* . This tells the program that blubb can be pre-ceded and followed by any characters.Use the tabs at the top left ofthe window to change to ‘Contents’ and ‘Properties’. In ‘Contents’,use ‘File type’ to limit the search to files or directories or search forthe content of the document. If you enter a keyword of the docu-ment to find in ‘Containing text’, all texts containing this word aredisplayed. Click the desired file to load it directly. With ‘Save as. . . ’,save the file under a new name in a different directory. The originalfile is retained.Search criteria can be specified in the ‘Properties’ dia-log. You can limit your search to files that were modified or createdrecently or to files that belong to a specific user or group.
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 4.1.7 The Windows
 The windows of all KDE applications have the same structure. The titlebar features four buttons in the right corner. The question mark providesaccess to context help. If you click the question mark then an icon of theapplication, a short help text is displayed. The button with the black dashminimizes the window. A minimized window is placed in the panel butnot terminated. Display it and continue to use it by clicking the icon in thetaskbar. The button with the square maximizes the window over the entirescreen area. Another click on this symbol restores the window to its formersize. The X closes the window and terminates the application.
 Windows can be moved, enlarged, or downsized. Click the title bar andkeep the left mouse button pressed to move the window on your screen. Ifyou right-click the top bar, a configuration menu is displayed. To changethe size of the window, move the mouse pointer along one of the fouredges of the window until the mouse pointer symbol changes to a doublearrow. Then keep the left mouse button pressed while moving this edge.Another possibility is to move the mouse pointer to one of the four cornersand resize two edges of the window at the same time.
 4.2 SettingsThe KDE desktop can be customized according to your preferences andneeds. ‘Control Center’ in the main menu opens the configuration dialogfor your KDE desktop. The following section introduces a number of mod-ules.
 4.2.1 Peripherals
 This opens the configuration dialogs for the mouse, keyboard, and printeradministration.
 Keyboard
 Keyboard repeat Keeping a key pressed causes the associated characterto be printed repeatedly as long as the key is pressed. The option isactivated by default.
 Key click volume If you want to hear a sound when a key is clicked, acti-vate this option and adjust the volume with the slider.
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Use sticky keys, slow keys, or bounce keysThese options are the same as those listed in Section 4.2.5 on page 57,
 where they are described in detail.
 NumLock on KDE startup Here, determine whether the number pad ofyour keyboard should be active when KDE is started.
 MouseThe mouse configuration comprises three tabs:‘General’, ‘Advanced’, and‘Mouse Navigation’. The configuration options of the ‘General’ tab are:
 Button Mapping Here, specify right-handed or left-handed use of yourmouse.
 Icons Determine how the system should react to clicks and double-clicks.The default setting for the KDE desktop is a single click for openingfiles or folders and a mouse pointer that changes its appearance whenit is moved over icons. If you want icons to be selected automaticallyin addition to the single click, activate the respective option and setthe delay for this selection.
 To use double-click for opening files and folders, select ‘Double-clickto open files and folders (select icons on first click)’. Finally, set thesize and color of the pointer and the visual feedback on activation.
 Configuration options of the ‘Advanced’ tab:
 Pointer Acceleration and Pointer ThresholdThe pointer acceleration defines the relation between the movementspeed of the input device (mouse) and the speed of the pointer on thescreen. The higher the selected factor is, the more difficult it is to con-trol the screen pointer. The threshold (in pixels) specifies the distancethe pointer must cover before the indicated pointer acceleration isactivated. In this way, control the mouse pointer easily when coveringsmall distances and cover large distances on the screen with smallmovements.
 Double Click Interval Here, set the maximum interval between twomouse clicks that should still be interpreted as a double-click.
 Drag Start Time and Drag Start DistanceThe object selected with a click is moved if you move it by the dis-tance in pixels specified in ‘Drag start distance’ within the periodspecified in ‘Drag start time’.
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 Mouse Wheel Scrolls By If you have a wheel mouse, specify the numberof lines the image should scroll per wheel “tooth”.
 To be able to navigate the mouse pointer with the arrow keys of the num-ber pad, activate this function under ‘Mouse Navigation’ and customizethe parameters according to your needs.
 Printers
 The printer administration module mainly consists of three parts. The topframe lists all printers available in the network. The center part features aconfiguration and information zone comprising four tabs. The lower partindicates the current print system type. The following description only cov-ers the configuration part.
 NoteThe configuration options relevant for your daily work with the systemcan be accessed under ‘Jobs’ and ‘Instances’. ‘Information’ and ‘Proper-ties’ mainly provide information or are used for system administration.
 Note
 Depending on which printer is currently selected in the overview, viewand modify status and model information and configuration options in thefollowing four tabs at the center of the dialog window:
 Information This tab provides general and unmodifiable informationabout the printer, such as the printer type, its status, location, anddesignation.
 Jobs This tab corresponds to KJobViewer, described in Section 4.4.5 onpage 66.
 Properties All settings related to the printer are available here: generalinformation, drivers, interfaces, separator pages, quotas, and useraccesses.
 Instances Depending on the document type, you may have diverse re-quirements for the printouts (page format, duplex printing, orienta-tion, print quality, and banners). Combine the characteristic settingsfor each type in instances. To create a new profile, select ‘New’ and en-ter a name for the profile. Click ‘Settings...’ to open a configurationdialog in which to specify these settings. To save the settings and exit
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the dialog, click‘OK’. To define one of your custom profiles as the de-fault for this printer, click ‘Set as Default’. Your default profile is usedwhen printing from applications. You can only switch between theindividual profiles in the printer administration module.
 4.2.2 Desktop
 Under ‘Appearance’, set the standard font, font size, background colors,and underlining on the desktop. Under ‘Window Behavior’, configure thebehavior of the windows and their activation. For example, set the focus tofollow the mouse. In this case, you do not need to click a window to acti-vate it.
 The taskbar in the panel displays the applications currently started on yoursystem. In this module, determine to what extent started programs and vir-tual desktops should be displayed in the taskbar and which actions shouldbe associated with mouse clicks in the taskbar.
 Under ‘Panels’, set the position and size of the panels and configure theirhiding mode. You can also place additional menus in the panel. If the stan-dard number of virtual desktops is not sufficient, set up additional virtualdesktops under ‘Multiple Desktops’ and assign them names.
 4.2.3 Sound & Multimedia
 Here, perform all settings for the playback of audio CDs and for the soundsystem. Under ‘System Bell’, switch from system notification to a systembell and specify the volume, pitch, and duration of the bell.
 By default, system notifications are used. Use this module to determinehow the system should inform you in the event of a problem, when a taskis performed, or if an event requiring your immediate attention occurs.
 In the upper part of the dialog, select the application for which to configurethe system notifications. As soon as you select a program, all events theapplication can send to the user are listed in the lower window. Determinethe notification type for each notification in the ‘Actions’ dialog.
 The standard view of the system notification dialog only offers the acti-vation of a ‘Play a sound’ check box for audible notification. Click ‘MoreOptions’ to access other action modes. You can log the notification to a file,execute a program, or show the message in a pop-up window. In the lowerpart of the dialog under ‘Quick Controls’, globally activate or deactivatethe actions for all programs.
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 4.2.4 Appearance & Themes
 This item features all fine tuning options for the appearance of your desk-top.
 Screen saver
 The module for selecting and configuring the screensaver consists of threeparts. Select a suitable screensaver from the list to the left. The preview tothe right shows how the selected program looks. Use ‘Setup’ and ‘Test’ totest the screensaver in the running system and configure it.
 Start screen saver automatically For the screensaver to be activated auto-matically, select this check box and specify the time (in minutes) afterwhich the screensaver should be activated.
 Require password to stop screen saverThe screensaver can block your workstation and require a passwordfor the release.
 Priority Use the slider to set the priority of the screensaver in relation toother processes. If you use a graphically complicated screensaver thatgenerates a high processor load, set the priority higher to achieve asmooth display quality. In this case, the priority of other processesis reduced accordingly. However, if you frequently let your machinework while you do other things, you should refrain from running acomplex screensaver with a high priority.
 Colors
 Use this module to manage and edit color schemes for your desktop. Selectone of the many existing schemes. The preview window displays all desk-top elements in the defined colors. To change the color of one or severalwidgets, select the name of the widget from the drop-down menu under‘Widget Color’ and click the color bar below to choose a suitable color inthe color editor. Finally, adjust the contrast settings and save the modifiedscheme under a name of your choice. To apply this scheme globally, acti-vate ‘Apply colors to non-KDE applications’.
 Window Decorations
 Select a decoration style for your application windows from the list un-der the ‘General’ tab. Click ‘Apply’ to test the selected style. To position or
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move individual elements of the title bar, activate ‘Use custom titlebar but-ton positions’ and rearrange the elements under the ‘Buttons’ tab. If addi-tional configuration options are available for the selected style, access theseunder the ‘Configure’ tab.
 Background
 Determine a background for your desktop. By default, your modificationsare applied to all virtual desktops. To configure the backgrounds separatelyfor the individual virtual desktops, deactivate ‘Common Background’. Theeffect of your configuration can be seen in the preview at the top right ofthe dialog window.
 The background colors can be selected under the ‘Background’ tab. Tomodify the color components, click the color bar next to ‘Color 1’ or ‘Color2’ to open a color editor. Here, change the color settings as desired or usethe pipette to adopt a color from any desktop element or a loaded image orweb page. Select special gradient effects under ‘Mode’.
 To use an image as a background for one or several backgrounds, activate‘Single Wallpaper’. Then select the scaling mode or the position of the wall-paper on your desktop and designate a suitable wallpaper with the drop-down menu or the ‘Browse...’ button. Alternatively, drag and drop imagefiles from your file manager (see Section 4.3 on page 58) or the desktop tothe preview image. For wallpaper variety, activate ‘Multiple Wallpapers’and proceed with the further configuration using ‘Setup Multiple...’.
 The ‘Advanced’ tab features some special settings that usually do not needto modified.
 Fonts
 All fonts and font attributes used on the desktop can be configured here.Click ‘Choose...’ then specify your settings in the dialog that opens. By de-fault, antialiasing is activated for all fonts. To deactivate or customize an-tialiasing, select the respective check boxes.
 NoteChanges to the antialiasing settings are only applied to newly-startedprograms. Programs already open are not affected by the changes.
 Note
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 Style
 Here, select the style for all widgets (elements of the graphical interface) inKDE applications. The configuration contains three tabs. Select the style un-der ‘Style’, using the preview in the lower part of the window. Use ‘Effects’to configure various GUI effects and transparency types, if supported bythe respective style.
 4.2.5 Regional & Accessibility
 Country/Region & Language
 The settings in this module only apply to KDE applications. Other applica-tions, such as OpenOffice.org, may need to be configured separately. Allregional system settings can be configured under five tabs.
 Locale Use the drop-down menu to select the desired country from thelist. Settings, such as the language, numbers, currency, time, and dateare automatically set to suitable values. A preview of all current re-gional settings is displayed in the lower part of the dialog. For exam-ple, to use the regional settings for the US but use Spanish as the sys-tem language, click ‘Add Language’ to select this language and add itto the list of available system languages. To remove a language, markit in the list and click ‘Remove Language’.
 Numbers To use different number settings than the default settings asso-ciated with the country selected under ‘Locale’, configure the decimalsymbol, thousands separator, positive sign, and negative sign in thisdialog. The decimal symbol and the thousands separator for curren-cies are configured separately under the ‘Money’ tab. The default set-ting on a US system is “.” for the decimal symbol, an optional “,” forthe thousands separator, no entry for the positive sign, and “-” for therepresentation of negative numbers.
 Money Configure all currency-related settings that should differ fromthe default settings for the selected system language in this dialog.For example, on a US system, the currency symbol is “$”, the decimalsymbol is “.”, thousands are separated with a “,”, and the numberof fraction digits is “2”. The position of the currency symbol and theprefix for positive and negative amounts is arranged in such a waythat the currency symbol precedes the prefix and the amount.
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Time & Date Here, enter the time format, the date format, the short dateformat, and the first day of the week. A detailed explanation is dis-played if you click the “?” symbol in the title bar then the respectivemenu item.
 Other This tab features the setting for the default paper format and mea-surements. On a US system, the default paper format is “US Letter”and the imperial system is used for measurements.
 Keyboard ShortcutsThis module comprises two tabs. Use the ‘Shortcut Schemes’ tab to selectan existing layout or create new keyboard layout schemes. The ‘ModifierKeys’ tab provides an overview of the special keys available on your key-board.Your system offers a number of predefined shortcuts for specific tasks ar-ranged in schemes. Use the ‘Shortcut Schemes’ tab to manage all shortcutson your system. By default, the following schemes are available on yoursystem:
 Windows Scheme (With Win Key)
 Mac Scheme
 KDE Default for 3 Modifier Keys
 KDE Default for 4 Modifier Keys
 Windows Scheme (Without Win Key)
 Unix Scheme
 To change the scheme used on your system, select one of the listed schemesand adopt it globally (‘Global Shortcuts’, ‘Shortcut Sequences’, and ‘Appli-cation Shortcuts’) or assign shortcuts to individual actions and save themas a custom scheme.To create a new shortcut for an action or modify an existing shortcut, selectthe tab for the respective area (e.g., ‘Global Shortcuts’) and click the actionto assign (e.g., ‘Show Taskmanager’). The section ‘Shortcut for Selected Ac-tion’ is then activated in the lower part of the dialog. Three radio buttonsoffer the basic configuration options none, default, and custom.Existing schemes are write-protected, allowing restoration of the defaultvalues at any time. Save your own modifications by clicking ‘Save...’ at thetop right and entering a name for your custom scheme. The new scheme isthen listed in the selection menu.
 56 4.2. Settings

Page 65
                        
                        

4Th
 eKD
 ED
 eskto
 p
 NoteUnder ‘Application Shortcuts’, you can only configure standard ac-tions available in all applications. Program-specific shortcuts must beconfigured in the program itself via ‘Settings’ -> ‘Configure Shortcuts’.
 Note
 Accessibility
 The settings in this module facilitate the access to the system for users withhearing problems or motor disorders. This module contains the ‘Bell’ and‘Keyboard’ tabs.
 Audible bell System bells can be communicated to the user in a visibleor in an audible form. The default setting is the audible variant with‘Use System bell’. To configure a specific sound, activate ‘Use cus-tomized bell’ and use ‘Browse...’ to select a suitable sound from thelist.
 Visible bell For system bells to be communicated visually, activate ‘Usevisible bell’. If no other modifications are performed, the screen is in-verted when a system bell rings (‘Invert screen’ is activated by de-fault). The duration of the visual bell can be adjusted with the slider.Instead of the inversion, the screen can be set flash. To do this, acti-vate ‘Flash screen’ and select a suitable color in the color editor byclicking the color bar.
 Sticky Keys Some shortcuts require a key to be held down (this is thecase with
 �� ��Alt ,�� ��Ctrl , and
 �� ��Shift ) while the second part of the shortcutis entered. If sticky keys are used, the system considers these keys tobe pressed continuously even if they are only pressed once.
 Slow Keys Here, determine if and to what extent the system delaysthe output of characters on the screen when a key is pressed. Thelonger the interval adjusted with the slider is, the longer a key can bepressed without triggering a repeated output of the respective charac-ter on the screen.
 Bounce Keys If you activate this option, pressing a key twice is only in-terpreted as two characters if the interval selected with the slider haselapsed. If a key is pressed twice inadvertently, this will be ignored.
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4.3 Konqueror as a File ManagerKonqueror is a unified web browser, file manager, document viewer, andimage viewer. The following paragraphs cover the use of Konqueror forfile management. Start Konqueror by clicking the house icon in the panel.The contents of your home directory are then displayed.
 The file manager window consists of the menu bar at the top, the toolbar,and the location bar. The lower part of the window is split vertically intothe navigation panel and the main window, which displays the contents.
 Figure 4.3: The File Manager Konqueror
 4.3.1 The Konqueror Menu
 Location Using the ‘Location’ menu, open additional Konqueror win-dows. If you click ‘New Window’, your home directory is displayedin a new window. ‘Duplicate Window’ produces a second windowwith the same content. You can also send a file or a link (using thebrowser function) by e-mail. If you click one of these menu items, theKMail composer opens. Specify the recipient and compose a text. De-pending on the selected item, the file is already attached or the link
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 is displayed in the e-mail body. You can also print directly from thismenu.
 Edit Most items under ‘Edit’ only become active if you select an objectin the main window. Standard editing functions are available. The‘Shred’ function destroys the data permanently. Create new directo-ries and files or change file properties, such as the file permissions.Grant or deny the user, a group, or all users read, write, and executepermissions. In the main window, one or several files can be selectedby moving the mouse pointer over them while keeping the left mousebutton pressed or by using the selection functions in the ‘Edit’ menu.
 View Use the ‘View’ menu to change views. If a directory is very full,the text view or the tree view may be more efficient. To view HTMLpages, activate ‘Use index.html’. With ‘Lock to Current Location’,stop animated images and, with ‘Unlock View’, resume the anima-tion. ‘Icon Size’, ‘Sort’, ‘Preview’, ‘Show Hidden Files’, and ‘FolderIcons Reflect Contents’ control the icons shown in the main window.Also use this menu to choose a color or image for the background.
 Go The ‘Go’ menu contains the navigation functions. However, you canaccess these functions more quickly in the toolbar. One interestingfeature is available under this menu: the list of recently viewed direc-tories, which can be selected and displayed.
 Bookmarks Bookmarks can be Internet addresses (URL) or paths to spe-cific files or directories on your host. If you select ‘Add Bookmark’,the current content of the location bar is saved as a bookmark. Toaccess this location, simply click this bookmark. For practical rea-sons, arrange bookmarks in folders. The SuSEfolder already exists.This folder contains bookmarks of important SUSE web pages. ‘EditBookmarks’ opens the bookmark editor in which to perform taskslike deleting obsolete bookmarks, renaming bookmarks, and movingbookmarks from one folder to another.
 Settings Use the ‘Settings’ menu to configure the look and feel of Kon-queror. Hide the menu bar by deactivating ‘Display Menubar’. Press�� ��Ctrl +
 �� ��M to display it again. Under ‘Toolbars’, hide or display themain toolbar, an extra toolbar, the location bar, and the bookmark list.If you changed the view of a specific directory, save these changes un-der ‘View Properties Saved in Directory’ or ‘Remove Directory Prop-erties’. Using view profiles, change the view by means of predefinedpatterns. The default setting is ‘File Management’. Under ‘Load ViewProfile’, switch to ‘File Preview’, ‘Midnight Commander’, or ‘Web
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Browsing’. For example, when you click the Konqueror icon in thepanel, the web browser profile is displayed. Specify individual key-board shortcuts with ‘Configure Shortcuts’, customize the toolbarwith ‘Configure Toolbars’, and configure global settings for the filemanager with ‘Configure Konqueror’.
 Window In the ‘Window’ menu, you can split the main window hor-izontally and vertically. With ‘Remove Active View’, remove thesplit. ‘New Tab’ creates an empty window in the Konqueror window.Switch between these windows with tabs. With ‘Duplicate CurrentTab’, generate a second identical window that can be loaded to a sep-arate Konqueror window with ‘Detach Tab’. You can also close theactive subwindow.
 Help Under the ‘Help’ menu, access the Konqueror handbook or the‘What’s This?’ function. This function can also be accessed via thequestion mark symbol at the top right in the title bar. The mousepointer is then displayed with a question mark. If you click an icon, abrief help text is displayed. The ‘Help’ menu also provides a short in-troduction to Konqueror and the possibility to report bugs and otherconcerns to the developers. ‘About Konqueror’ and ‘About KDE’ pro-vide information about the version, license, authors, and translationsof the project.
 4.3.2 The Toolbar
 The toolbar provides quick access to frequently-used functions that canalso be accessed via the menu. If you let the mouse pointer rest above anicon, a short description is displayed. Right-click a free space in the toolbarto open a menu with which to change the position of the toolbar, switchfrom icons to text, change the icon size, and display or hide the individualbars. The configuration dialog can be started with ‘Configure Toolbars’. Tothe right, the toolbar features the Konqueror icon, which is animated whilea directory or web page is loaded.
 4.3.3 The Location Bar
 The location bar is preceded by a black symbol with a white X. If you clickthis icon, the contents of the line are deleted, allowing entry of a new lo-cation. Valid locations can be path specifications, like the one that appearswhen the home directory is displayed, or web page URLs. After entering
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 an address, press�� ��Enter or click ‘Go’ to the right of the input line. Access
 directories or web pages visited recently via the black arrow to the rightof the location bar. This function saves some typing if you need to accesscertain contents repeatedly. For even more convenience, create a bookmark.
 4.3.4 The Main Window
 The main window displays the content of the selected directory. If you clickan icon, the respective file is displayed in Konqueror or loaded into therespective application for further processing. If you click an RPM package,the description is displayed. Install the package with ‘Install package withYaST’.If you right-click an icon, a menu opens. The kind of menu displayed de-pends on the file type and offers common actions, such as ‘Cut’, ‘Copy’,‘Copy’, ‘Paste’, and ‘Delete’. Use ‘Open with’ to select the application withwhich to open the file from a list of suitable programs. Files can be en-crypted directly in Konqueror. However, to use this function, a key mustbe generated manually or in KGpg.The quickest way to perform many actions is the drag and drop method.For instance, easily move files from one Konqueror window to another bysimply dragging them there while pressing the left mouse button. Subse-quently, you will be asked whether the objects should be moved or copied.
 4.3.5 Creating an Image Gallery
 To facilitate the management of extensive image collections in a directory,Konqueror can generate an HTML file with thumbnails. Open the respec-tive directory in Konqueror and select ‘Tools’ -> ‘Create Image Gallery ...’.A dialog opens in which to specify the background and foreground col-ors, the page title, the location to which to save the gallery, and other set-tings. Click ‘OK’ to start the action. By default, a file called index.htmlis created. If you click this file in Konqueror, your images are displayed ina miniaturized, well-arranged view. Click an image to access the full-sizeview.
 4.4 Important UtilitiesThe following pages introduce a number of small KDE utilities intendedto assist in daily work. These applications perform various tasks, such as
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managing your keys for encrypting and signing files and e-mail messages,managing your clipboard, formatting floppy disks, compressing and de-compressing diverse file archive types, and sharing your desktop withother users.
 4.4.1 KInternet — Connecting to the Internet
 To surf the Internet or send and receive e-mail messages, connect a modemor an ISDN or Ethernet card to your machine and configure it. This can bedone with the help of the system assistant YaST. As soon as the respectivedevice has been configured correctly, control the Internet dial-up with KIn-ternet.
 On start-up, KDE loads KInternet. The program checks whether an Inter-net connection can be established. If this is possible, the application icon, aplug, automatically appears in the right part of the KDE panel. The follow-ing is an overview of the icons and their meanings:
 Currently there is no connection to the Internet.
 The connection is just being established or terminated.
 The connection has been established.
 Data is transmitted to or from the Internet.
 An error has occurred. If a connection has already been configuredwith YaST, use ‘View Log ...’ to identify the reason for the error. Themenu can be accessed by right-clicking the KInternet icon.
 The connection is not yet active, but will be established as soon as arequest is made.
 Right-click KInternet to access a menu for configuring KInternet. To con-figure your access, select ‘Settings ...’ -> ‘Configure with YaST ...’. After en-tering the root password, YaST is started. Depending on the access type,start the modem, ISDN, network, or DSL configuration of YaST to select aprovider from a list.
 KInternet can do even more: if the option ‘Channel Bundling’ is activatedin YaST, a second ISDN channel can be added to an existing connectionwith ‘Add link’. This doubles the transfer rate (although at a higher price).
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 Activate channel bundling if you need to download large files. The acti-vated channel bundling is evident from the red plus symbol at the top leftcorner of the KInternet icon.
 Users who want to establish Internet connections automatically can use dialon demand (DoD). If this mode is selected, KInternet automatically connectsto your Internet service provider (ISP) as soon as a request is submitted.After a certain time-out, the connection is terminated. A DoD connectionis evident from the blue D at the bottom right corner of the KInternet icon.DoD only makes sense if you have a flat rate Internet account. Otherwisethe repeated establishment and termination of the connection can be quitecostly.
 4.4.2 The Download Manager KGet
 KGet is the download manager for KDE, similar to GetRight or Golzilla.With
 KGet, manage your transfers in a window. Stop, resume, delete, and queuetransfers and add new transfers.
 Adding TransfersStart KGet by pressing
 �� ��Alt +�� ��F2 and entering the command kget . When
 the program is started for the first time, a dialog is displayed. Confirm thisdialog to integrate KGet in Konqueror. When you close the dialog, KGetis integrated in the system tray of the panel as an icon with a downwardarrow.
 Click this arrow to open the dialog displaying your transfers. To add atransfer to the list, select the menu item ‘File’ -> ‘Paste’. A dialog opens. En-ter a URL in the input field and confirm with ‘OK’. Then specify the loca-tion for saving the downloaded file. After all information has been entered,the entry for the transfer is added to the main window of KGet and started.
 Another way to add a transfer is by means of drag and drop. Simply draga file (e.g., from an FTP server) from Konqueror and drop it in the mainwindow.
 Timer-Controlled TransfersYou can also instruct KGet to perform your transfers at a specific time. Ac-tivate ‘Options’ -> ‘Offline Mode’. All transfers inserted from this point arenot started immediately but queued. To start the clock, double-click the re-spective entry. A dialog opens. Select ‘Advanced’. The dialog is expanded
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by the settings needed for starting the transfer at a certain time. Enter theday, month, year, and time. Then close the window.
 After making the desired settings for all your transfers, set KGet back tothe online mode by deactivating ‘Options’ -> ‘Offline Mode’. The transfersshould start at the specified times.
 Settings
 In ‘Settings’ -> ‘Configure KGet ...’, set preferences for the connection, de-termine directories for specific file extensions, and specify other settings.
 4.4.3 SuSEWatcher
 SuSEWatcher is a program that is integrated in the system tray of thepanel. It checks for new updates and new hardware. To be able to find anynew updates, it requires an online connection. The program SuSEWatcheris located in the package kdebase3-SuSE . The status of SuSEWatcher isdisplayed by means of colorful icons in the panel.
 When you click the icon in the panel, a window opens, informing youabout the status of your online updates and the availability of any newupdates. You can also launch the check manually by clicking ‘Check forupdates’. Start the online update by selecting ‘Start online update’ and en-tering the root password. The YaST Online Update window is displayed.
 4.4.4 The Clipboard Klipper
 The KDE program Klipper serves as a clipboard for selected text, normallymarked by keeping the left mouse button pressed. This text can be trans-ferred to another application by moving the mouse pointer to the targetlocation then pressing the middle mouse button (on a two-button mouse,press both buttons simultaneously). The text is copied to the selected loca-tion from the clipboard.
 By default, Klipper is started when KDE is loaded and appears as a clip-board icon in the panel. View the contents of the clipboard by clicking thisicon. The Klipper context menu and the last seven entries, also referred toas the history, are displayed (see Figure 4.4 on the facing page). If an exten-sive text was copied to Klipper, only the first line of the text is displayed.The most recent entry is listed on top and is marked as active with a blackcheck mark. To copy an older text fragment from Klipper to an application,
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 Figure 4.4: The Clipboard Klipper
 select it by clicking it, move the mouse pointer to the target application,and then middle-click.
 As well as the contents of the clipboard, the context menu features the fol-lowing menu items:
 Enable Actions If you click this, a black check mark is displayed in frontof it. For example, if you mark a URL with the mouse when actionsare enabled, a window opens, enabling you to select a browser fordisplaying this URL. Click ‘Actions Enabled’ to disable this function.
 Clear Clipboard History Deletes all entries from the clipboard.
 Configure Klipper... This opens the Klipper configuration dialog. Klip-per can be customized in many ways. Control the program with key-board shortcuts or use regular expressions. Check the Klipper hand-book for details. Former Windows users may appreciate the optionfor activating the keyboard shortcuts
 �� ��Ctrl +�� ��C and
 �� ��Ctrl +�� ��X for cut-
 ting and�� ��Ctrl +
 �� ��V for pasting under the ‘General’ tab. To use this fea-ture, activate the entry ‘Synchronize contents of the clipboard and theselection’ in ‘Clipboard/Selection Behavior’. Subsequently, use themouse or the keyboard shortcuts to which you are accustomed.
 Help This item opens a submenu from which to open the Klipper hand-book, send a bug report to the developers, and view informationabout Klipper and KDE.
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Quit If you click ‘Quit’, a dialog is displayed asking whether Klippershould be started automatically the next time you log in. If you click‘No’, start the program from the main menu the next time you wantto use it. If you click ‘Cancel’, the program will not be terminated.
 4.4.5 Monitoring Print Jobs
 Start KJobViewer from the main menu or with the command kjobviewerfrom the command line. This program assists with monitoring print jobs.Print jobs are placed in a queue, from which they are sent to the printerconsecutively. As long as your jobs are not printed, edit them with the‘Jobs’ menu or by clicking the respective icon. See Figure 4.5.
 Figure 4.5: Monitoring Print Jobs with KJobViewer
 If, for example, you want to check if you sent the correct document to theprinter, you can stop the job and resume it if you decide to print it. Removeyour own print jobs from the queue with ‘Remove’. To change the printer,select a different printer with ‘Move to Printer ...’.With ‘Restart’, reprint a document. To do this, select ‘Toggle CompletedJobs’ from the ‘Filter’ menu, select the desired document, and click ‘Restart’in the ‘Jobs’ menu. ‘Job IPP Report ...’ contains the technical details of a job.Use ‘Increase Priority’ and ‘Decrease Priority’ to set the priority, dependingon how quickly you need the document.‘Filter’ enables you to switch between various printers, toggle completedjobs, and limit the view to your own print jobs by selecting ‘Show OnlyUser Jobs’. The current user will be displayed in the top right field.‘Settings’ -> ‘Configure KJobViewer ...’ opens a configuration dialog. Here,determine the maximum number of print jobs to display. Enter a numberin the field or use the slider to the right to determine a value. Press ‘OK’ tosave the setting or ‘Cancel’ to exit the dialog without saving.
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 The icons in the toolbar correspond to the functions you can access by wayof the menu. A help text explaining the function is displayed when youmove the mouse pointer over one of the icons.
 The job list consists of eight columns. The job ID is automatically assignedby the print system to identify the various jobs. The next column containsthe login of the user who sent the job followed by the file name of the doc-ument. The status column indicates whether a job is still in the queue, cur-rently being printed, or already completed. Next, the size of the documentis displayed in kilobytes and number of pages. The default priority of 50can be increased or reduced if necessary. Billing information can be costcenters or other company-specific information. If you right-click a job in thelist, the ‘Jobs’ menu opens under the mouse pointer, allowing you to selectan action. Only a few functions are available for completed jobs. If you acti-vate ‘Keep window permanent’, KJobViewer window opens automaticallywhen you log in the next time. You can also start KJobViewer using theprinter icon in the panel.
 4.4.6 Formatting Floppy Disks with KFloppy
 KFloppy is the floppy disk formatter of KDE. Start the program fromthe main menu or from the command line with the command kfloppy .KFloppy opens a dialog, shown in Figure 4.6 on the following page, inwhich to specify a number of settings. Under ‘Floppy Drive’, select the pri-mary or the secondary drive, provided your machine has two floppy diskdrives. The default setting for the size is ‘3.5” 1.44 MB’, which is the mostcommonly used floppy disk type. The setting for the file system is very im-portant. Choose between the Linux format ext2 and MS-DOS. If you selectMS-DOS, you will be able to read and write the floppy disk on a Windowsmachine.
 In the center, select ‘Quick Format’ or ‘Full Format’. The quick format pro-cedure merely rewrites the file system and deletes all data. The full formatprocedure rewrites all tracks and sectors and is able to detect and mark badsectors. Sectors marked as bad are not used for writing data. Select ‘VerifyIntegrity’ to have the formatting checked and verified upon completion.If you activate ‘Volume Label’, designate a name for the floppy disk in theinput field below.
 After making all settings, click ‘Format’. You will be warned that all dataon the disk will be lost and prompted to confirm. KFloppy informs you ifany problems occur during the formatting procedure, including informa-tion about any bad sectors.
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Figure 4.6: The Floppy Disk Formatter KFloppy
 Click ‘Help’ to access a short menu that offers the KFloppy handbook. Ad-ditionally use it to send a bug report or other concerns to the developersof KFloppy. Selecting ‘About KFloppy’ accesses information about the ver-sion, authors, translation, and license. ‘About KDE’ provides informationabout KDE and web pages of the KDE developers. Exit KFloppy by clicking‘Quit’.
 4.4.7 Ark: Displaying, Decompressing, and CreatingArchives
 To save space on the hard disk, use a packer that compresses files and di-rectories to a fraction of their original size. The application Ark can beused to manage such archives. It supports common formats, such as zip ,tar.gz , tar.bz2 , lha , rar , and zoo .
 Start Ark from the main menu or from the command line with the com-mand ark . If you already have some compressed files, move these froman open Konqueror window to the Ark window to view the contents of thearchive. To view an integrated preview of the archive in Konqueror, right-
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 click the archive in Konqueror and select ‘Preview in Archiver’. Alterna-tively, select ‘File’ -> ‘Open’ in Ark to open the file directly. See Figure 4.7.
 Figure 4.7: Ark: File Archive Preview
 Once you have opened an archive, perform various actions. ‘Action’ offersoptions such as ‘Add File’, ‘Add Directory’, ‘Delete’, ‘Extract’, ‘View’, ‘EditWith’, and ‘Open With’.To create a new archive, select ‘File’ -> ‘New’. Enter the name of the newarchive in the dialog that opens. If you enter a file extension, an archivewith the specified format is generated. If you omit the extension, .zip isused as the default.After you have entered the archive name, an empty window is displayed.Move files or directories into this window from Konqueror. Ark com-presses and lists the files. For more information about Ark, go to ‘Help’ ->‘Ark Handbook’.
 4.4.8 Desktop Sharing
 You can share your desktop for use by other users on their hosts. Desk-top sharing makes use of the RFB protocol, more commonly referred to asVNC. This feature enables a Linux desktop to be made available for clientsusing other operating systems, provided they support VNC.To grant trustworthy users access to your desktop, send them a password.This can be done by means of an invitation. Start the Control Center fromthe main menu and select ‘Desktop Sharing’ in the ‘Internet & Network’module.Click ‘Create & manage invitations’ and choose between ‘Create PersonalInvitation...’ and ‘Invite via Email’. If you click ‘Create Personal Invita-tion...’, an invitation indicating the IP address of the host, password, and
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expiry of the invitation is generated. Send this data manually to the respec-tive person. If you click ‘Invite via Email’, all required data is transmittedby e-mail. KMail starts automatically and generates an e-mail message withthe needed data (host, password, and expiry). At the end of the e-mail, alink, which the recipient of the message merely needs to click to view yourdesktop in a browser, is provided. Simply enter the e-mail address of therecipient and modify the standard text, if necessary. Then send the mes-sage. Refer to Figure 4.8.
 Figure 4.8: Desktop Sharing with Invitation by E-Mail
 Use ‘Delete All...’ to revoke all invitations. To delete an individual invita-tion, select it then click ‘Delete...’.If an invited person requests a connection, KDE informs you about this re-quest. Decide to accept or deny the connection. If you accept the connec-tion, also use the check box to release the keyboard and mouse control. Forsecurity reasons, the maximum duration for a connection is one hour.To change the default settings, start the ‘Control Center’ via ‘Settings’ in themain menu. In the left frame, select ‘Internet & Network’ -> ‘Desktop Shar-ing’. Various configuration options are available in the lower part of thewindow. However, for security reasons you should not modify the defaultsettings.
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 4.4.9 KSnapshot: Taking Screenshots
 With KSnapshot, create snapshots of your screen or special applications.Start the program from the main menu or from the command line with thecommand ksnapshot . The dialog window of KSnapshot consists of twoparts (see Figure 4.9). The upper area (‘Current Snapshot’) contains a pre-view of the current screen and three buttons for creating and saving thescreenshots. In the lower part of the window, determine further options forthe actual creation of the screenshot.
 Figure 4.9: Taking Screenshots with KSnapshot
 To take a screenshot, use ‘Snapshot delay’ to determine the period in sec-onds to wait between the click on ‘New Snapshot’ and the actual creationof the screenshot. If ‘Only grab the window containing the pointer’ is ac-tive, only the window containing the pointer is “photographed.” To savethe screenshot, click ‘Save Snapshot...’ and designate the directory and filename for the image in the following dialog. Use ‘Print Snapshot...’ to printthe screenshot.
 4.4.10 Kontact
 The application Kontact bundles the display of e-mails, notes, contacts,news, weather, and a calendar into one window. Open it by pressing
 �� ��Alt -
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�� ��F2 and entering kontact . See Figure 4.10.
 Figure 4.10: Kontact
 In ‘Settings’ ➝ ‘Configuring Kontact’, select which components should ap-pear in the window.
 4.4.11 Chatting With Friends: Kopete
 Kopete is an online messenger application allowing multiple partners con-nected to the Internet to chat with each other. Kopete currently supports allcommon messenger protocols, such as ICQ, MSN, Yahoo, SMS, Jabber, andIRC.
 Configuring Kopete
 Configure Kopete by entering your personal user data. Click ‘Settings’ ->‘Configure Kopete’. ‘Connections’ shows all currently available protocols.Check the desired connection type to activate it.
 With ‘Accounts’, enter your user data. You must register with a provideroffering instant messaging services before using such service. Click ‘New’to open a configuration assistant that can assist you in completing youruser profile.
 The next step lists the avilable messaging services. Select the service withwhich you have registered and click ‘Continue’. In the next step, enterthe user data received upon registration with the messaging service. This
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 usually consists of the nickname or e-mail address and the password youchose. Complete the configuration of the messenger account by clicking‘Finish’.
 Figure 4.11: Kopete Configuration Panels
 The next item in the configuration dialog is ‘Appearance’. It influences howKopete is displayed. The tab ‘Emoticons’ provides a selection of varioustypes of smileys.
 The tabs ‘Chat window’ and ‘Colors & Fonts’ offer the possibility to adjustthe appearance of the chat windows for communication with other partic-ipants. Choose between the classic themes of the corresponding providersor to create a custom theme by adjusting the font or color to personal pref-erence.
 Adding Contacts
 It is necessary to add contacts in order to chat with a participant. If youhave already created an account on another PC, this data is readily im-ported and automatically added to your contact list. To create a contactentry manually, click ‘File’ -> ‘Add contact’.
 A new assistant appears automatically that will accompany you until com-pletion. However, consider that must be online to add a contact to your list.
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Adding Groups
 Access this with ‘File’ ➝ ‘Create New Group’. Name the group and confirmthis with ‘OK’. A new folder appears in the contact list that can be used tostore the desired contacts. You can drag and drop contacts into the desiredfolder. This allows grouping contacts for a better overview.
 Figure 4.12: The Main Kopete Application
 Using Kopete
 It is necessary to establish a connection to the Internet to be able to chatwith other participants. When this is done, clicking ‘File’ ➝ ‘Connection’ ➝‘Connect All’ then establish a connection between Kopete and the selectedmessaging service.
 The main application windows features a list of contacts. When you right-click a contact marked as online, a menu opens with various options. Sendthat person a message or start a chatting session. A chat allows invitationof other participants for real-time discussion. The connection to all otherparticipants is closed when the creator of the chat session leaves the roomfirst.
 Files can be transferred comfortably with an instant messenger by right-clicking a user and then clicking his name. Many options, like ‘Delete Con-tact’, ‘Show User Information’, ‘Block User’, and ‘Send File’, can be foundhere. Clicking ‘Send File’ opens a dialog for selecting the desired file. Con-firming with ‘OK’ sends a dialog to the receiving user asking whether hewants to accept the file. If he accepts, the file transfer starts.
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 4.4.12 Font Administration
 By default, SUSE LINUX provides various fonts commonly available indifferent file formats (Bitmap, TrueType, etc.). These are commonly knownas System Fonts. Users can additionally install their own fonts from variouscollections on CD-ROM. Such user-installed fonts are, however, only visibleand available to the corresponding user.
 The KDE control center provides a comfortable tool for administering sys-tem and user fonts. It is shown in Figure 4.13.
 Figure 4.13: Font Administration from the Control Center
 To check which fonts are currently available, type the URL fonts:/ intothe address field of a Konqueror session. This displays two windows:Personal/ and System/ . User-installed fonts are installed to the folderPersonal/ . Only root can install to the System/ folder.
 To install fonts as a user, follow these steps:
 1. Start the Control Center and access the appropriate module with ‘Sys-tem Administration’ ➝ ‘Font Installation’.
 2. Choose ‘Add Fonts’ from the icon bar or from the menu availablewhen right-clicking the list.
 3. In the dialog that opens, select one or more fonts for installation.
 4. The marked fonts are then installed to your personal font folder. Se-lecting a font shows a preview.
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To update system fonts, first select ‘System administration mode’ and enteryour root password then proceed as described for user font installation.
 The feature for deactivating installed fonts is very useful. They are not re-moved but are made unavailable to the system. Select the ‘deactivate’ iconor its counterpart from the context menu. This makes the green checkmarkdisappear. The new settings become active after confirmation with ‘Apply’.The deactivated fonts are then no longer available to applications. This re-duces the size of font lists displayed in applications.
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